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Disclaimer 
The information in this document is provided solely in connection with the product and a reasonable 
effort has been made to have it accurate and reliable, however, we do not assume any liability 
whatsoever for the accuracy and completeness of the above information. The manufacturer reserves 
the right to make changes, corrections, modifications or improvements to this document, and to the 
products and services described herein, at any time and without notice. No representations or 
warranties, either express or implied, of merchantability, fitness for a particular purpose or of any other 
nature are made hereunder with respect to information/specification or the products to which 
information refers and no guarantee with respect to compliance to the intended use is given. In 
particular, this also applies to the stated possible applications or areas of applications of the product. 
 
The customers are responsible for the appropriate, safe and legal use, processing and handling of our 
products. 
 
Manufacturer 
This product is manufactured in Italy by Eoptis Srl. 
 
Life-support policy 
The product is not designed for use in life-support appliances, devices or systems where malfunction 
of these products can reasonably be expected to result in personal injury. Customers using or selling 
these products for use in such applications do so at their own risk, and agree to fully indemnify the 
manufacturer for any damages resulting from such improper use or sale.  
 
Copyright, Trademarks and IP 
All of the materials in this document are protected by copyright and other laws of intellectual property. 
They are not allowed to be copied, reproduced or modified for any use without the written permission 
of Eoptis. 
 
Eoptis and the Eoptis logo are trademarks of Eoptis Srl.  
 
The company names and other product names in this document might be the trademarks and trade 
names of their respective owner(s), and are hereby acknowledged.  
 
WEEE  
This product should not be treated as household waste. Please ensure that this product is correctly 
disposed of, as inappropriate waste handling can cause potential hazards to the environment and 
human health.  

 
 
 
 

Made in Italy by 

 
Eoptis Srl 

Via Kufstein, 15 - 38121 Trento (TN) - Italy 
Tel: +39 0461 260552 

Email: info@eoptis.com 
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1 OVERVIEW 

Thank you for purchasing the Eoptis' CLM-194, a handheld digital tristimulus colorimeter. The CLM-194 is a 
handheld compact device for colorimetric detection with a reliability higher than human eye and at a 
competitive price. Color measurements can be performed on the surface of a wide range of matte and glossy 
materials, thanks to a (45°c:0°) measurement geometry and the very uniform illumination provided by 
integrated LEDs. Long-term stability reduces the need of calibration by the user. The device is powered and 
interfaced through a USB port using a standard PC or laptop with a Microsoft Windows operating system.  
 
After having performed the measurement of the sample of interest, the application software allows you to: 

• evaluate the color difference from a reference patch, to determine whether a sample is within a user-
defined acceptance limit 

• classify samples among a set of selected colors, in order to group them in classes with homogeneous 
color and improve uniformity 

• find the best match of the sample, looking up a color database to reproduce the measured color. 
 
The color database is encoded in software, avoiding the use of bulky physical sample libraries. Color sets 
such as RAL are included as standard and a custom or application-specific color database can be added by 
the user or with Eoptis's support on request. 
 
 
 
1.1 PACKAGING LIST 
The package contents: 
 
 1   CLM-194 colorimeter 
 1   White reference standard 
 1   USB stick with software and manuals 

1 User Guide 
 1  Certificate of traceable calibration (depending on order options) 
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2 SYSTEM AT A GLANCE 

 

System ports 
 

Item Description 
  
1 Measurement aperture with sealed glass window 
2 Handle 
3 Handle end with stand pad 
4 Instrument label with serial number 
5 Display panel 
6 USB cable for power and data interface 
7 Acquire button 
8 Function button 
9 Eoptis logo indicator 
10 ACQ indicator 
11 M indicator 
12 R indicator 
13 White reference standard 
14 White reference label with instrument serial number 
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Indicator status description 
 

Indicator Status Description 
   

EOPTIS OFF system not powered or not recognised by host PC 
Red steady ON system powered and correctly recognised by host PC 

M Green steady ON system in Measure mode (alternative to Reference mode) 
R Green steady ON system in Reference mode (alternative to Measure mode) 

ACQ Red steady ON color acquisition in progress 
OFF ready for a new acquisition 
Red Dimmed waiting for next acquisition during Multiple Acquisition mode 

 

Button operations 
 

Button Action Description 
   

Acquire (left) Single click triggers a new acquisition to start 
Double click enable/disable Multiple Acquisition mode 

Function (right) Single click toggles between Reference and Measure mode 
Double click undo last operation 
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3 COLORIMETRY BACKGROUND 

This section provides you with useful information about colorimetry and how to get the best results 
from the system in real world applications. 
 
3.1 MEASUREMENT GEOMETRY 

The CLM-194 colorimeter is designed to measure the samples the way the human eye does in the real 
world. It implements a (45°c:0°) geometry, that uses 45° circumferential illumination by means of 
multiple directional sources and 0° viewing perpendicular to the sample plane, according to ASTM E 
1164. The circumferential illumination is essential to achieve repeatable measurements on directional 
and structured surfaces.  
 
The (45°c:0°) instrument is capable of specular excluded (SPEX) readings, that exclude the specular 
or gloss component from measurement. The (45°c:0°) geometry simulates the normal condition used 
for color evaluation, where a difference in gloss and texture o a sample with same pigmentation results 
in a difference in color. A gloss sample is indeed visually judged darker by the eye when compared to 
a matte or structured sample.  
 
Several applications require agreement between measurement and visual assessment, therefore 
implicitly assuming the (45°c:0°) measurement geometry: 
 

• batch to batch comparison in production and quality acceptance  
• assembly of multi-component products using different materials 
• printed materials and the graphic arts industry, where a (45°c:0°) is the conventional 

measurement geometry 
• reproduction of the color of a sample taking into account texture and gloss 
• and many others. 

 
If only the pigmentation difference is to be detected or different textures of the same material are to be 
compared, a specular included geometry (SPIN) that includes the gloss components in readings is 
recommended. This is usually achieved with (d:8°) sphere geometries.  
 
Note that only measurements taken under the same conditions can be compared. Measurements 
taken with (45°c:0°) and other geometries match only under a very limited set of conditions and often 
exhibit differences of several ΔE units.   
 
Relevant conditions affecting measurements are: 

• measurement geometry 
• illuminant / observer pair 
• color system  
• sample preparation and orientation. 
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3.2 SAMPLE PREPARATION 

An ideal sample to achieve repeatable and accurate color measurements with a reflectance colorimeter 
like the CLM-194 has the following characteristics (see also ASTM E1164): 

• a flat surface 
• completely opaque with no translucency 
• clean and dry 
• uniform across the area being measured  
• large enough to cover the instrument's sample port 
• its color is not affected by light (photochromic), moisture (hygrochromic) or heat 

(thermochromic) 
• it adequately represents the material or parts under evaluation. 

 
If any of these qualities is not present, the sample must be made as ideal as possible for a correct 
measurement.  
 
Translucency by a non-opaque sample is often the main source of error. Part of the light incident on a 
translucent sample penetrates the surface and undergoes internal scattering and lateral diffusion, 
which reduces the intensity of reflected light. Ambient light might also penetrate the instrument port 
and affect the measurement in an uncontrolled way. A translucent sample must be made as opaque as 
possible either by increasing the thickness and/or by backing it with an stable and durable opaque 
material (usually black or white). The chosen thickness and baking material should be logged in 
measurement report to ensure repeatability.  
 
To select a sample which adequately represents the part under evaluation, examine a sufficient number 
of random samples from the lot, and average the readings.  
 
In case of an uneven surface, the instrument optically averages the color on the area corresponding to 
the measurement spot. For longer range non-uniformities, it is recommended to average several 
measurements taken at different positions on the sample to find the closest match (see the Multiple 
Acquisition feature in 5.9.4). 
 
Textured surfaces can be presented to the instrument at any orientation. The circumferential 
illumination allows reading which is unaffected by sample orientation. In very limited cases where the 
surfaces are highly textured, it is recommended to turn the sample and check differences on multiple 
readings.  
 
Several published standards address sample selection for various industries (fibers, yarn, liquids, 
powders, coatings, paints, papers, leather, etc...). Contact Eoptis for additional information and support 
in identifying the best technique to exploits the full performance of the colorimeter.  
 
Repeatable and accurate measurements may be difficult or impossible to obtain if some samples have 
any of the following characteristics:  
 

• a surface which contains fluorescent pigments or appears unusually bright 
• an appearance which changes based on the point of view (may contain metallic, flake, or 

pearlescent colorants) 
• a very curved, highly uneven or corrugated surface. 
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4 SYSTEM SETUP ON FIRST USE 

4.1 RECOMMENDED SYSTEM CONFIGURATION 

• Windows XP/Vista/Seven/10/11 32(x86) or 64(x64) bits 
• Intel Pentium 4 2.0 GHz or compatible processor  
• Graphics card and monitor capable of displaying 1280x1024 resolution at 32-bit color depth 
• 100 MB of free hard disk space 
• USB2.0 port, with a supply current of 500mA 

 
4.2 DRIVERS AND SOFTWARE INSTALLATION 

1) Connect the software USB 
stick 
 

 
 

Software, drivers and third-party packages required by the system 
are installed by means of the Installer executable, provided on the 
USB stick. Automatic detection of the operating system and of any 
missing packages is supported.  
Launch the “CLM194Setup.exe” by double-clicking on it and follow 
the instructions. The file is not signed by Microsoft and the 
Operating System might prompt for approval to proceed. It is 
necessary to grant the approval in order to successfully complete 
the installation.  
The installation sequence is: 

- CLM194 application software 
- Microsoft .NET Framework (*) 
- Micosoft Visual C++ redistributable packages 
- Device drivers 

 (*) installed only if not already present. 
 

2) Plug the USB cable  into the 
host machine’s USB 2.0 port 
and confirm successful 
installation 

 
 

At the end of the software and driver setup, plug the USB cable into 
a free USB port of the PC. The red EOPTIS logo indicator on the 
colorimeter will illuminate. If not, check the Troubleshooting section. 
 
 

  

http://en.wikipedia.org/wiki/Redistributable
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3) Launch the Application 
Software 
 

A shortcut of the application software is created on the desktop and 
in the Start menu, unless otherwise specified during setup. 
Launch the software by double-clicking on the desktop icon. 
The green M indicator on the colorimeter will illuminate and the 
serial number of the device will be shown in the bottom-left corner 
next to the “Device connected” label. 
Congratulations, the system is ready for use! 
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5 SOFTWARE OPERATIONS 

This section explains the software features. The buttons, checkboxes or active items in the user 
interface include a pop-up help function which appears when the mouse is held over the item for few 
seconds. 
 
5.1 MAIN CONTROLS 

This section describes the main controls of the user interface. 
 

 
Main controls 
 

Item Description  Item Description 
       
❶  Main menu with toolbar  ❺  Advanced control panel 

 ① Measure Acquisition button   ⑪ Illuminant/Observer selection 
 ② Reference Acquisition button   ⑫ Multiple Acquisition control 
 ③ Undo button  ❷❸  Measure/Reference control panel 
 ④ Operating Mode selector   ⑤ Measure/Reference active indicator 
 ⑬ Save Report button   ⑥ Color space selector 
❹  Output control panel   ⑦ Color coordinates   

     ⑧ Color Groups 
     ⑨ List of Measures/References 
     ⑩ Database control buttons 

6 

1 4 2 3 
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The main menu ❶ on the top of the interface allows you to:  
 handle Projects    see 5.9.3  File→New project | Load project… | Save project… 
 generate Reports    see 5.7  File→Save report… 
 perform user calibration  see 5.8  System→User calibration 
 reset user calibration  see 5.8  System→Reset user calibration 
 reconfigure system  see 5.9.8 System→Reconfigure system… 
 change language    System→Language 
 set preferences   see 5.9.6 System → Preferences… 
 get system information    Help→About  
 
The main toolbar ❶ features three pushbuttons that allow you to:  
 ① Acquire Measure data 
 ② Acquire Reference data 
 ③  Undo the last operation 
These buttons feature the same functions of the Function (right) and Acquire (left) button of the 
colorimeter, as described in 2. 
 
The four central icons ④ switch between the various operating modes featuring the following 
functions: 
 Color Difference Check  see 5.3  
 Color Matching    see 5.4  
 Color Classification  see 5.5 
 L*a*b* Chart   see 5.6 
 
The central Output control panel ❹ changes according to the selected operating mode function and 
shows specific controls and outputs, as described in the relevant sections. 
 
The Measure and Reference control panels ❷ ❸ include all the controls needed to perform and 
manage the color data acquisition. Each acquisition can be either addressed as a Measure or a 
Reference depending on its expected usage. Measure and Reference data are indeed handled in 
different ways depending on the selected operating mode function, as described in 5.3 to 5.6. It is 
possible to exchange previously acquired Measures and References, as described in 5.9.1.  
 
The Measure and Reference Modes can be selected by a a click on the Function (right) button on the 
colorimeter. The active mode is highlighted ⑤ on the panel and once a color is acquired, the data is 
added to the list of the highlighted section. In both cases, each acquired color will be added to the 
Default Group ⑧ of the Color List ⑨. The last acquired color will become the current color, used as 
input by the operating mode functions, and its coordinates will be displayed ⑦ in units according to 
the selected color space ⑥. The user can select a previously acquired color by double clicking on it in 
the list or by dragging it to the corresponding Display Area in the Output control panel.  
 
The Measure and Reference Lists can be managed by means of the Database Control buttons ⑩, as 
described in 5.9.1.  
 
The Save Report button ⑬ allows you to save a report of the current measures and analysis results in 
.pdf and Excel-readable .xml formats. See 5.7 for details. 
 
The Advanced Control panel ❺ includes:  
 ⑪ Multiple Acquisition control, to average a sample     see 5.9.4 
 ⑫  Illuminant and Observer controls     see 5.9.5 
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5.2 MEASURE AND REFERENCE ACQUISITION 

The acquisition of Measure and Reference color data is performed through these steps: 
 

1. Connect the device 
2. Launch the software 
3. Ensure that the sample to be acquired has the characteristics listed in the   
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4. Sample Preparation section, 0 
5. Ensure that the device’s glass window is clean, otherwise follow the instructions in 7.1. 
6. Place the colorimeter’s measurement aperture in perfect contact with the sample surface 
7. Trigger the acquisition 

 
Hardware-triggered acquisition  Software-triggered acquisition 

Select the Measure or Reference mode 
using the Function (right) button. Hit the 
Acquire (left) button to trigger the 
acquisition. 

 Click the Measure acquisition button or 
the Reference acquisition button. 

 
8. Wait until the ACQ indicator switches off, and the acquisition will be complete  
9. Select the desired Operating Mode function and configure its options to analyse the acquired data. 

 
If required, the system allows you to average multiple acquisitions. This feature is useful in the case of 
samples with uneven or structured surfaces. See 5.9.4 for details. 
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5.3 COLOR DIFFERENCE CHECK  

 

 

The Color Difference Check function performs a fast check of the color difference 
between the Measure and the Reference colors, a group of Reference colors or the 
entire Reference database, providing a quantification of the CIE 1976 a,b color 
difference (CIELAB) ΔE*ab. Measure is ranked according to threshold levels set by user, 
allowing to definition of acceptance or rejection criteria based on objective elements. 
The result can be used for the quality control of a product, to evaluate the color aging 
of an object and for many other applications. 

 
 

Color Difference Check interface 
 

Item Description 
  
① Color Difference Check mode selector 
② Measure color display area 
③ Reference color display area 
④ Reference Mode selector  
⑤ CIELAB ΔE*ab color difference between Measure and Reference 
⑥ CIELAB ΔL* lightness difference, CIELAB ΔC*ab chroma difference, Δa* and Δb* components 

difference between Measure and Reference 
⑦ Acceptance Thresholds values for ΔE*ab color difference 
⑧ Visual representation of the ΔE*ab color difference compared to the Acceptance Thresholds 
⑨ Acceptance threshold validation result 
⑩ Acceptance class (rank) of the current Measure 
⑪ Plot of the current Measure in the L*a*b* color space with Reference set at the origin of axes. 
⑫ Open Color Check settings panel 
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5.3.1 HOW TO PERFORM A COLOR DIFFERENCE CHECK ANALYSIS 

1. Select the Color Difference Check function from the Operating Mode selector 
2. Select and setup the Color Check mode from the Color Check settings panel ⑫  
3. Acquire a desired Reference sample. Either select an existing sample from the References list 

or let the software detect the closest to Measure, belonging to the selected group of the 
Reference list 

4. Acquire the data of the Measure sample under evaluation. If acquisition has already been 
performed, any color in the Measure list can be selected by double-clicking on it 

5. The software performs the color difference calculation and shows the results of acceptance 
threshold validation and plots the CIE L*a*b* Measure coordinates against the Reference ones 

 
5.3.2 COLOR CHECK ANALYSIS MODES 

Color Check analysis works in Classes mode or in Thresholds mode. The mode and parametrization is 
done via the Color Check settings panel ⑫. The analysis results are displayed in a different way, given 
the mode selected. 
 
Classes mode 

 
 

In Classes mode, the software will compute the distance between the current measure and reference 
colors, and puts the measure in a given “quality class” given the set classes thresholds. The measure 
can fall in 3 classes, or be out of threshold. 
 

 
 
Given the selection in the Preferences Panel (see 5.9.6) the user can select to display the results graph 
in two ways: 
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• Classes range: controls the dE ranges for the CIE L*a*b* color check graph 
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• Coordinates range: controls the single coordinates ranges displayed when the color check chart 
is displayed in the current color space (different from CIE L*a*b*) 

 

 
 
It also possible to show the L*a*b* chart (see also 5.6). 
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Threshold mode 
 

 
 

In Thresholds mode the user can setup two acceptance ranges, each defined by up to three thresholds 
on various quantities. The user can define limits for the various measure/reference distances (e.g. -2 
< dL* < 2 and dE*ab < 3); the software will signal if any of the quantities exceeds the threshold. A range 
of values can be defined for the measure’s coordinates (e.g. 80 < L* < 85), without comparing it to a 
reference; again, the software will signal when the selected cordinates’ ranges are exceeded. The 
quantities used for the analysis are highlighted in the main interface; when a quantity exceeds its range 
it will be displayed in red; otherwise in green. 
 

 
 
To display info on the Chroma and Lightness plot (see 5.3.4), based on measure/reference dE*ab, the 
user can select two dE*ab ranges, even when this quantity isn’t selected for any range. 
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5.3.3 USING THE INTERFACE 

 

 

The acquired color is displayed on the monitor as a guide only. It is very likely that it 
will appear to be different from the actual color of the sample. This is due to several 
factors (such as the ambient light, monitor calibration, gamma settings, …) which 
must be controlled and fine tuned in order for the colors to match.  

The Reference can be selected in two different ways, using the Reference Mode selector ④.  
 

Manual mode. Manual mode is enabled by selecting the MANUAL option in the Reference Mode 
selector ④. In Manual mode, the user selects a color from the Reference List by double-clicking 
on it, by dragging it to the Reference color display area ③, or by acquiring a new Reference color. 
Manual mode allows the color difference of the current Measure (either that just acquired or 
selected from the Measure list) to be evaluated with respect to a Reference which is fixed and 
does not change during operations. 

 
Automatic mode In automatic mode the software automatically chooses the Reference color 
selecting the most similar (lower ΔE*ab) to the current Measure. If the ALL option is selected in 
the Reference Mode selector ④, the color will be chosen among all colors in the Reference list. 
If the corresponding group name is selected, a color group will be chosen. Automatic mode 
allows the user to highly speed up the Color Difference Check when a large set of samples 
comprised of a subset of various colors is to be checked. The user does not need to select the 
right Reference when a new sample is being acquired since the software automatically detects 
it. The automatic selection process is effective even on very similar colors if a group of Reference 
colors to be selected is specifically built and the ΔE*ab difference between these colors is larger 
than the highest Acceptance Threshold. 
 

The software displays the color difference between Measure and Reference following the formula used 
in the CIE 1976 a,b (CIELAB) ΔE*ab color difference ⑤; the same formula for color difference is used 
for other color spaces, using the relative color space’s coordinates. Single components differences, as 
well as chroma difference, are also provided ⑥. 
 

ΔE*ab=√(L*1 − L*0)
2 + (a*1 − a*0)

2 + (b*1 − b*0)
2 

 
ΔC*ab=√(𝑎 ∗1)

2 + (𝑏 ∗1)
2 −√(𝑎 ∗0)

2 + (𝑏 ∗0)
2 

 
ΔL*=L*1 − L*0 ; Δa*=a*1 − a*0 ;  Δb*=b*1 − b*0 
 
being (L*1; a*1; b*1) the Measure coordinates and (L*0; a*0; b*0) the Reference coordinates. 

 
Note that not all color spaces have chroma info available, and not all color spaces have 3 coordinates 
(e.g., see 5.9.7 Custom color spaces). 
The color differences will be used to perform the analysis. Classes mode will always use the colors’ 
distance. Threshold mode will use the selected differences/coordinates.  
 

5.3.4 CHROMA AND LIGHTNESS PLOT 

 
The Chroma and Lightness plots ⑪ show the Measure coordinates, plotted against the Reference 
coordinates set at the origin of axes. Also the three Acceptance Thresholds are displayed as boundaries 
in these plots. The graphs and the colored ticks (Red/Green for a*, Yellow/Blue for b*, Black/White for 
L*) help the user to understand which component is the prevalent source of color difference between 
Measure and Reference.  
See also 5.3.2 for details regarding the plot display modes.  
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5.4 COLOR MATCHING 

 

 

Given a current Measure, the Color Matching function displays the 5 most similar 
colors, looking up the References list or a subset of it. A proprietary or standard 
database (RAL classic and RAL design) can be used as the Reference list. The closest 
matching colors are ranked by increasing CIELAB color difference with respect to the 
current Measure. This information can be used to select the color that resembles the 
measured sample by simply checking a best-candidate color palette instead of looking 
up a large set of physical samples.  

 
Color Matching interface 
 

Item Description 
  
① Color Matching mode selector 
② Measure color display area 
③ Reference color display area (up to 5) 
④ Reference rank 
⑤ Color ID 
⑥ CIELAB color distance between Measure and Reference 
⑦ Reference group selector for best match look-up 

 
  

2 4 

3 
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5.4.1 HOW TO PERFORM A COLOR MATCHING ANALYSIS 

1. Select the Color Matching function from the Operating Mode selector 
2. Select a group from the Reference group selector.  
3. Acquire the data of the Measure sample to match. If acquisition has already been performed, 

any color in the Measure list can be used by double-clicking on it. 
4. The best matching candidates will be shown. 

 
5.4.2 USING THE INTERFACE 

 

 

The acquired color is displayed on monitor the as a guide only. It is very likely that it 
will appear to be different from the actual color of the sample. This is due to several 
factors (such as the ambient light, monitor calibration, gamma settings, …) which 
must be controlled and fine tuned in order for the colors to match.  

The Color Matching function shows the References ranked according to the CIELAB difference of each 
Reference with respect to the current Measure. The search will be performed among colors belonging 
to the group selected by the Reference group selector ⑦. To search all colors from the Reference list, 
select the ALL option. More info about the management of color groups can be found in 5.9.2. 
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5.5 COLOR CLASSIFICATION 

 

The Color Classification allows the user to select up to 5 colors and check which is the 
most similar to a measured sample. This is useful when sorting products with similar 
but slightly different colors or when assigning an object to a batch of homogenous 
colors, using the color as classification parameter. Samples can be grouped into sets 
with a color shift towards the same direction (lighter, darker, greenish, bluish, reddish) 
and therefore improve color homogeinity by reducing the color difference among 
samples of the same set. With this feature, sorting and classification processes 
become much more reliable and accurate than visual inspection.  

 
Color Classification interface 
 

Item Description 
  
① Color Classification Mode selector 
② Measure color display area 
③ Reference color display area 
④ ΔE*ab color difference between Measure and Reference 
⑤ Color Remove button 
⑥ Classification Result indicator 
⑦ Maximum Threshold 
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5.5.1 HOW TO PERFORM A COLOR CLASSIFICATION ANALYSIS 

1. Select the Color Classification function from the Operating Mode selector 
2. Select up to 5 colors to be used as class identifiers from the References list by dragging them 

in the Reference color display area 
3. Set a Maximum Threshold value. This prevents a Measure which exceeds a specified color 

difference. 
4. Acquire the data of the Measure sample under evaluation. If acquisition has already been 

performed, any color in the Measure list can be used by double-clicking on it. 
5. Verify which class the sample has been assigned to. 

 
5.5.2 USING THE INTERFACE 

 

The acquired color is displayed on the monitor as a guide only. It is very likely that it 
will appear to be different from the actual color of the sample. This is due to several 
factors (such as the ambient light, monitor calibration, gamma settings, …) which 
must be controlled and fine tuned for the colors to match.  

In the Color Classification interface, the user can select up to 5 colors from the References list. The 
selection can be made by dragging the colors from the References list to one of the five sections in the 
Reference color display area ③. These colors will set the classes to which the measured sample may 
belong. The colors can be removed by clicking on the remove button ⑤. 
 
Once a Measure is available (either just acquired or selected by double-clicking in the Measure list), 
the Color Classification engine will identify the class to which the Measure belongs and place the 
Classification Result indicator ⑥ next to the corresponding Reference color. The ΔE*ab difference 
between the Measure and each Reference is also shown ④. 
 
If the difference between the Measure and all the classes exceeds the set maximum threshold ⑦, the 
Measure is not assigned to any class. In this case the classification result indicator is removed and an 
‘X’ icon will be displayed next to the Maximum Threshold selector ⑦. 
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5.6 L*A*B* CHART 

 

The L*a*b* chart displays all the colors in the Measure list on a graphical 
representation of the CIELAB color space. This provides the user with visual 
information about where the sample lie in the color space.  

 
CIE L*a*b* interface 
 

Item Description 
  
① CIE L*a*b* Chart Mode selector 
② Chromaticity plot (a*, b*) 
③ Lightness plot (L*) 

 

2 

3 
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5.7 REPORT GENERATION 

 
The software can generate a report of the data in the Measure list by clicking the Save Report button 
① or accessing the menu option “File→Save report…”. The report can be saved in PDF or XML format. 

 
 
The PDF report shows the name and the actual color of each measured sample, as well as the CIELAB 
coordinates and other relevant information related to the selected analysis feature. All data are sorted 
by groups. If a note is added to the color, it will also be printed on the PDF. A user logo will be printed 
at the top of the report. To customise the printed logo, replace the file “UserLogo.png” in the software 
executable folder with an image file with the same name and format; this file will be automatically loaded 
during report generation. The recommended size is 277x165 (other sizes will be rescaled). 
 
The XML format Is meant to be used for off-line analysis purposes. The file can be opened with a 
spreadsheet program (such as MS Excel, LibreOffice Calc, …), so the included data can be used to 
analyse the acquired data. For each entry, the report displays the color name, the CIELAB coordinates, 
the group, any note added by the user and date/time information and other relevant information related 
to the selected analysis feature.  
 

1 
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5.8 USER CALIBRATION 

Each colorimeter is supplied with its own white reference standard, necessary to perform the user 
calibration. The standard is manufactured from highly stable materials and labelled with a unique serial 
number. Ensure that the colorimeter is used with its matching white reference standard and that the 
serial numbers match, otherwise calibration will lead to unpredictable results that may compromise 
system accuracy. The software prompts for calibration when necessary. Before proceeding with the 
creation of a database, it is recommended to calibrate the system using the white reference standard. 
 
To perform the calibration:  

1. Ensure the standard is clean otherwise clean it with a moist cloth. Do not use acetone or alcohol. 
2. Access the calibration panel on the “System→User calibration” software menu. 
3. White target: apply the measurement aperture of the colorimeter to the White Calibration 

Standard and click the Acquire button. 
4. Dark: place the measurement aperture of the colorimeter at a distance of about 1m from the floor, 

pointing downwards and click the Acquire button. Make sure no direct sunlinght or other intense 
light sources are impinging on the floor, over an area of about 1m x 1m located under the 
colorimeter. 

o NOTE: Dark calibration can be skipped. It is useful to perform this measure only with 
systems with an aperture <10mm 

 
 

 

 
 

Step 3. Acquisition of White Calibration standard Step 4. Acquisition of Dark 
 
Reset user calibration 
 
If the measures look wrong after an user calibration, it is possible that the procedure failed due to target 
coupling or other factors. Repeat the procedure to fix the error. 
If the measures continue to look wrong, the user can restore the factory calibration from the menu 
“System→Reset user calibration”. 
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5.9 ADVANCED FEATURES 

5.9.1 DATABASE MANAGEMENT 

The colors acquired and added to the Measures and References lists are organized in databases. In 
this way, the colors lists can be saved/loaded for future use. Note that the Measures and References 
databases are fully interchangeable, so one can choose to use a Measures database as a References 
database (and vice versa) when performing analysis. 
The colors are added to the database when performing an acquisition; they can then removed by right-
clicking on a color in the list and selecting “Remove item”. From this same menu one can also add notes 
to the color and rename it. 
 
All colors in a database are organised in groups. There will always be a “default group”, while other 
groups are user defined; the maximum allowed number of user defined groups is 15. Every newly 
acquired sample will be added to the default group. For more info about groups management, see 5.9.2. 
 
The groups of the Measures list are used mainly to organise the colors, while groups in the References 
list can be used to filter the results in Color Difference Check and Color Matching functions. The 
Database Control buttons can be used to manage the software’s current databases as well as 
previously stored databases. 
 

 
Database control buttons 
 

Item Description 
  
① Create new database 
② Merge databases  
③ Load database  
④ Save database  
⑤ Lock/Unlock database  

 
The Create new database button ① removes all colors from the list so you can start with an empty 
database. 
The Merge databases button ② allows you to merge a previously saved database with the current 
database; all the colors and groups in the saved database will be added to the current database. 
With the Load database button ③ you can load a previously saved database, removing all current 
colors. 
The Save database button ④ allows ypu to save a database on the computer for future use. Files can 
be saved in .cdb (proprietary), in .pdf and .xml (Excel readable) format. The following flags can be 
adding to the database when saving: 

• Is read only: the database becomes a read-only; no colors or colors grup can be added, removed 
or updated, as well as color groups. This is a “soft” lock that can be removed with the 
Lock/Unlock database button 

• Has hidden coordinates: the colors coordinates are hidden; only the color name can be seen by 
the user. This flag can be used to release a proprietary database without sharing sensitive data 
about the colors. Note that this flag, once set, can’t be removed. 

The Lock/Unlock database button ⑤ allows you to toggle the read-only mode for the database. This 
can be used to prevent database modification during color analysis.  
 

3 2 1 4 5 
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5.9.2 DATABASE CONTEXT MENU 

A context menu, displayed by right-clicking on the colors list, allows the user to perfom several actions 
on single and multiple colors, as well as on the whole database. 
 

 
 

• Rename item… : change name of the selected color 
• Add notes…: add notes to the selected color for future reference 
• Save analysis report…: (only for Measures database) save report only for the selected measures 
• Delete item: remove the selected color(s) from the database 

o The action can be done without accessing the context menu by selecting the desired 
color(s) and pressing Canc or Backspace key 

• Add to group: the selected color(s) will be added to one of the existing listed group, or a new 
group can be created (“New group…” option) 

• Edit group name…: change the name of the group that the selecter color belongs to 
• Remove group: remove the color’s group from the database. All the colors belonging to this 

group will be moved to “default group” 
• Move to References|Measures: move the selected colors in a given group in the other database, 

removing them from the current database 
• Copy to References|Measures: copy the selected colors in a given group in the other database 
• Average selected colors: generates a new color with coordinates set to the average coordinates 

of the selected colors 
o NOTE: the average will be performed on the coordinates of the currently selected Color 

space (e.g. CIE L*a*b*); due to the non-linear nature of color spaces transformations, 
the new color’s coordinates can differ from the average in color spaces diferrent form 
the currently selected one 

• Search…: search a color in the database that contains a given string 
• Find next: find the next item in the database that satisfies the search request 

o The action can be done without accessing the context menu by pressing the F3 key 
when the desired database is selected (any color on the database is selected) 

• Sort database: sort the database by color name or by color acquisition date 
o The database will be sorted alternately ascending and descending 

• Save on reference file…: save the selcted color as a reference file for CLM195 Interface software 
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5.9.3 PROJECT MANAGEMENT 

The “File” list in the software main menu is used to manage projects. The software treates each 
program session as a project that cointains all relevant information about the Measures and References 
databases, including analysis parameters. With this feature you can save the current session and 
resume a previously saved one.  
When loading a previously saved project or creating a new project, the current database entries and 
analysis parameters are replaced by the saved data or deleted.  
 

5.9.4 MULTIPLE ACQUISITION 

Multiple Acquisition should always be performed in cases of uneven or structured surfaces. The 
advantage of Multiple Acquisition is that the visual evaluation is supplemented by the calculation of a 
mean for the measured values. The Mutiple Acquisition feature is enabled by specifying the number of 
measurements to be averaged and by thicking the corresponding checkbox. Multiple Acquisition mode 
can also be toggled by double-clicking the device’s Acquire (left) button. The ACQ indicator on the 
system display panel will be dimmed until the last acquisition is performed. 
 

 

 
 

Continuous measure 
 
When multiple acquisition is enabled, the user can enable and start Continuous measure. Once started, 
the software will automatically acquire all the multiple measures needed to generate the final average 
measure, with a delay of 2 seconds between each acquisition. 
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5.9.5 ILLUMINANT-OBSERVER PAIR SELECTION 

The interface’s Advanced control panel allows the user to set the Measure Illuminant (SI) and Observer 
(SO) pair. The following options are available and can be selected in any (SI;SO) combination. The 
selected combination is automatically saved for future software sessions, when it will be restored and 
used as default settings.  
 

Illuminant Notes Approximate correlated color temperature 
   
D65 (*) Noon daylight (reference for sRGB color 

space) 
6500K 

D55 Mid-morning daylight 5500K 
D50 Horizon light 5000K 
A (*) Incandescent / tungsten 2850K 
C North sky daylight 6800K 
FL2 Cool white fluorescent 4230K 
FL7 Broadband fluorescent, D65 daylight 

simulator 
6500K 

FL11 Narrow band fluorescent Philips TL84, 
Ultralume 40 

4000K 

 
 (*) CIE standard illuminant  

Observer 
 
CIE 1931 2° standard colorimetric observer 
CIE 1964 10° standard colorimetric observer 

 
Performance specifications refer to (D65; 2°) pair, which is the recommended setting to be used 
whenever possible.  
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5.9.6 PREFERENCES PANEL 

 
 
From the preferences panel the user can configure some extra options for the color analysis modes. 
 
Color Check 
The user can select the format of the Color Check graph. 
 

• Always display Color Check graph in CIE L*a*b* color space: if checked, the graph will be 
displayed in CIE L*a*b* color space regardless of the currently selected color space. If not 
checked, the single coordinates’ delta is displayed. 

• Display CIE L*a*b* color space graph in Color Check tab: if checked, a copy of the L*a*b* chart 
from the relative tab will be displayed in the Color Check tab. The user can select which part of 
the chart to display. 

 
See 5.3.2 for further details. 
 

5.9.7 CUSTOM COLOR SPACES 

The software manages various standard color spaces (CIE-XYZ, CIE-xyY, CIE-L*a*b*, …). It is possible 
to add further user-defined color spaces and perform analysis on them. 
The coordinates of the custom color spaces are computed by applying user-defined mathematical 
operations on the coordinates of a given source standard color space. The formulas, as well as other 
color space’s parameters (the new color space’s name, coordinates’ names, …) will be defined in a text 
file that must be saved in the folder  
 
C:\Users\Public\Documents\EOPTIS\CLM19x Software Suite\ini\customColorSpaces 

 
An example file README.ini is provided; all instructions to generate new files and edit the parameters 
are described in said file. 
All custom color spaces’ files will be parsed by the software CLM19x Interface at startup. Custom color 
spaces can be selected from the Color space selector (see 5.1 Main Controls) as any other standard 
color space. 
 

5.9.8 ACCESS SYSTEM MEMORY 

The user can upload system memory files (*.clm) on the device. This features useful when multiple 
field of views adapters are used. When switching to a new field of view adapter, the user must upload 
the corresponding memory file to ensure correct color readings. 
To upload a memory file: 

1. Open the panel from System→Reconfigure system… 
2. Press “Load file…” button and select the correct .clm file 
3. Press “Apply” to load the data 

 
It is also possible to download current memory data, that EOPTIS can use to debug any major 
measurement problem, using the menu System→Download system data…  
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6 TECHNICAL SPECIFICATIONS 

 
Item Description 
  
Instrument class Tristimulus colorimeter 
Sensor type Color sensor based on the standard spectral value of the CIE 

1931 color matching functions as per DIN ISO 13655 and DIN 
5033 

Measurement mode Reflective  
Acquisition mode Button-triggered or software-triggered  

Single or multiple readings 
Working distance Contact 
Measurement geometry Circumferential 45° illumination and 0° viewing, according to 

CIE15:2004, ASTM E1164 
Light source 16 LEDs  
Color scales CIE-XYZ, CIE-xyY, CIE-L*a*b*, CIE-L*C*h*, CIE-L*u*v*, sRGB 

(where applicable), user-defined 
Color differences E*ab (CIE 1976), C*ab, L*, a*, b* 
Illuminant D65, D55, D50, A, C, FL2, FL7, FL11 
Observer CIE1931-2° and CIE1964-10° standard colorimetric observers 
Short-term repeatability  0.03E*ab typ – D65/2°, standard deviation of 30 measurements 

every 5 s on white reference standard under Eoptis standard 
conditions (*) 

Illumination/Measurement area Ø10mm /Ø18mm 
Size of smallest measurable 
specimen 

Ø23mm flat surface 

Measurement time <0.1 s, with 5 s minimum recommended measurement interval 
Recommended warm-up time 20 minutes 
Dimensions Approx. 225 mm (L) x 84 mm (H) x 99 mm (W) excluding cable 
Weight Approx. 710 g 
Interface USB 2.0, 500 mA rated 
Power requirements USB self-powered, 2.5 W peak, 0.6 W typical 
Operating ambient temperature 10 °C to 40 °C  50 °F to 104 °F 
Storage temperature 0 °C to 60 °C  40 °F to 140 °F 
Humidity range  20-80% RH non-condensing 
Protection rating IP54 
Usage Indoor use  
Standards traceability  Instrument standard assignment in accordance with National 

Institute of Standards and Technology (NIST) following 
practices described in CIE Publication 44 and ASTM E259 
(Standard Practice for Preparation of Pressed Powder White 
Reflectance Factor Transfer Standards for Hemispherical and 
Bi-Directional Geometries) 

Standard accessories (Packing list) - White reference standard 
- User guide 
- PC utilities disk and interface drivers 
- Certificate of traceable calibration (if ordered) 
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Main Software features  - Check: Pass/fail with thresholds and automatic look-up of 
reference color 
- Match: Search for closest standard in pre-loaded or custom 
database 
- Classify: Classification under selected standards 
- Average multiple readings 
- Data import/export to proprietary database 
- Data export to .pdf and Excel-readable . xml format  
- Generation of analysis report in .pdf and Excel-readable . xml 
format 
Note: availability of some features may vary by version 

Data view - Color Data (see available scales above)  
- Color Difference Data (see color differences indexes above) 
- CIE-L*a*b* Color Plot 

Software language English, Italian (Italiano), Chinese (中文), Portugues (Portugues), 
French (Français) 

 
(*) 25 °C, 50% RH, 20’ warm-up 
 
Specifications subject to change without notice. 
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7 APPENDICES 

7.1 PRECAUTIONS AND SYSTEM MAINTENANCE 

When handling the colorimeter, avoid touching the glass window. The window is recessed and 
therefore protected from dirt during normal usage. However, if it does require cleaning: 
 

• at first, blow short bursts of clean, dry air onto the window 
• if dirt has not been removed, use an optical lint-free cloth dampened with distilled water and 

gently wipe the window without applying excessive force 
• in the case of a very soiled surface, contact Eoptis for support. 

 
Occasionally wipe the outside of the meter with a soft water-dampened cloth. The housing components 
are made out of synthetic materials. Thus, avoid contact with acetone and similar detergents that 
contain solvents. Remove any splashes immediately. 
 
The device is designed for indoor use. Extended exposure to bright sunlight, rain, dusty environments, 
etc. may damage the electronics and the optics of the system. Avoid excessive shaking, dropping or 
mishandling of the device. 
 
7.2 TROUBLESHOOTING 

Problem 
 The EOPTIS logo on the device display is off after having connected the USB cable to the PC. 
Solutions   

1) The drivers are not correctly installed:  check proper driver installation section and, in case 
the CLM194 is not displayed, install drivers.  To check the Device Manager to confirm that 
installation was successful, go to the Windows Start menu, select Run and enter 
“devmgmt.msc”. You will find the “CLM-194 Colorimeter” under the “Ports (COM & LPT)” 
section. 

2) The USB port is not capable of supplying full current (500mA): change port or disconnect 
USB devices (such as external hard drives and speakers) which are connected to other 
ports. 

3) Operating condition undefined or excessive EMC load: unplug and reconnect the USB 
cable, then re-start the software. 

 
Problem 
 The usb cable is plugged but software displays “Device not connected” and the green “M” 
indicator is off. 
Solutions  

1) Drivers are not properly installed:  check proper driver installation section and, in case the 
CLM194 is not displayed, install drivers. To check the Device Manager to confirm that 
installation was successful, go to the Start menu, select Run and enter “devmgmt.msc”. 
You will find the “CLM-194 Colorimeter” under the “Ports (COM & LPT)” section. 

2) A system error initial: re-start software and re-connect the cable. 
 
Problem 
 The color displayed on the screen differs from the color of the sample. 
Solutions  

This is not a malfunction. The measured color is displayed on the monitor as a guide only. 
Differences are common and it is very likely that the measured color will appear to be different 
from the color of the sample. This is due to several factors (such as the ambient light, monitor 
calibration, gamma settings) which must be controlled and fine tuned in order for the colors to 
match. Contact Eoptis to check how your PC can be tuned to improve matching. 
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Problem 
 The measured color data are obviously incorrect. 
Solutions  

1) Ensure the sample perfectly adheres to the measurement port. 
2) Ensure the sample and the glass window of the measurement port are clean. 
3) Check that the units is within its operating temperature range. 
4) Perform a user calibration using the white reference standard. 

 
7.3 STANDARDS  

CIE15:2004 General terminology of colorimetry and basic data 
 

DIN 5033 Colorimetry; basic concepts 
 

DIN 5036 Radiometric and photometric properties of materials; definitions 
characteristics 
 

DIN 6174 Colorimetric evaluation of color differences of surface colors according to the 
CIELAB formula 
 

ASTM D2244 Standard Test Method for Calculation of Color Differences from Instrumentally 
Measured Color Coordinates 
 

ASTM E308 Standard Practice for Computing the Colors of Objects by Using the CIE 
System 
 

ASTM E1164 Standard Practice for Obtaining Spectrophotometric Data for Object-Color 
Evaluation 

 
7.4 WARRANTY AND REPAIR 

Eoptis warrants to the Original Purchaser that the product provided with this package is guaranteed to 
be free from material and manufacturing defects for a period of one (1) year from shipment date. Should 
a unit fail during this period, Eoptis will, at its option, repair or replace the damaged unit. Repaired or 
replaced units will be covered for the remainder of the original equipment warranty period. This 
warranty does not apply to units that, after being examined by Eoptis, have been found to have failed 
due to customer abuse, mishandling, alteration, improper installation or negligence or are beyond 
reasonable reparability. Warranty is void if any proprietary labeling is removed.  
 
Eoptis expressly disclaims and excludes all other warranties, express, implied and statutory, including, 
but without limitation, warranty of merchantability and fitness for a particular application or purpose. In 
no event shall Eoptis be liable to the Original Purchaser or any third party for direct, indirect, incidental, 
consequential, special or accidental damages, including without limitation damages for business 
interruption, loss of profits, revenue, data or bodily injury or death.  
 
Products within the warranty period may be returned for repair. Outside the warranty period, products 
may still be returned for repair; however, a fee will be charged. The customer is responsible for shipping 
costs to and from Eoptis.  
 
An RMA number is required before an Eoptis product can be returned. Products that are returned 
without an RMA number may be refused and returned to the sender, or may result in unnecessary 
processing delays. An RMA number and repair service may be requested via info@eoptis.com.  
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8 REVISION HISTORY 

 
Version Date Description 
   
Rev.0.9 08.2013 Preliminary release 
Rev.0.10 09.2013 Software functions description added 
Rev.0.11 09.2013 Advanced features added 
Rev.1.0 09.2013 Initial full release 
Rev.1.01 09.2013 Minor corrections 
Rev.1.02 12.2013 Setup procedure updated, additional Illuminant and Observer pairs supported 
Rev.1.03 12.2013 Minor updates 
Rev.1.04 03.2014 Table of specs added.  

Upgrade for software Rel.1.3.2:  
- report features added 

database can be saved in .pdf and .xml format. 
Rev.1.05 06.2014 English language corrections. 

Upgrade for software Rel. 1.3.5:  
(SI;SO) pair is saved and restored at new software session. 

Rev.1.06 12.2014 User Calibration procedure updated with Dark acquisition. 
Rev.1.07 02.2022 Added description of Database context menu 
Rev.1.08 04.2022 Described USB stick installation 
Rev.1.09 10.2022 Description of function Color Check; Thresholds mode 

Description of user-defined color spaces usage 
General revision 

Rev.1.10 03.2025 Rebranding 
Added “Copy/Move to other database” context menu notes 
Added “Preferences panel” description 
Updated screenshots to last version 
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